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Preface

Profile

Before You Begin This Course

Before you begin this course, you should have the following qualifications:

• Thorough knowledge and proficiency in navigating Oracle applications

• Working experience with a working experience of the manufacturing
business process

Prerequisites

• Oracle Inventory

• Oracle Bills of Material and Oracle Engineering

• 11i Overview of Flow Manufacturing (e-class)

• 11i Overview of Managing Demand in a Flow Environment (e-class)

• 11i Designing and Balancing Flow Lines

How This Course Is Organized

This is an instructor-led course featuring lecture and hands-on exercises.  Online
demonstrations and written practice sessions reinforce the concepts and skills
introduced.
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Related Publications

Oracle Publications

Title Part Number

Oracle Inventory User’s Guide A83507-01

Oracle Bills of Material User’s Guide A75087-01

Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide
A82941-01

Oracle Flow Manufacturing User’s Guide A69396-01

Oracle Work in Process User’s Guide A83598-01

Additional Publications

• System release bulletins

• Installation and user’s guides

• read.me files

• Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab
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(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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Flow Lines

11i Sequencing and Scheduling
Flow Lines
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ObjectivesObjectives

After completing this course, you should be able to
do the following:
• Schedule production through the Line Scheduling

workbench
• Name the business drivers that affect the choice of

a scheduling policy
• Describe how to protect production from demand

variability (volume and mix)
• Manage your line schedules through the Line

Scheduling workbench. View unscheduled orders
– Create, view, and maintain flow schedules
– Check component availability

After completing this course, you should be able to
do the following:
• Schedule production through the Line Scheduling

workbench
• Name the business drivers that affect the choice of

a scheduling policy
• Describe how to protect production from demand

variability (volume and mix)
• Manage your line schedules through the Line

Scheduling workbench. View unscheduled orders
– Create, view, and maintain flow schedules
– Check component availability
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ObjectivesObjectives

After completing this course, you should be able
to do the following:
• List the process steps for creating flow schedules

on synchronized feeder lines
• Demonstrate when and how to roll flow line

schedules

After completing this course, you should be able
to do the following:
• List the process steps for creating flow schedules

on synchronized feeder lines
• Demonstrate when and how to roll flow line

schedules
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• Defining and creating scheduling rules
• Using the Line Scheduling Workbench
• Rolling flow line schedules
• Synchronizing feeder lines

• Overview
• Defining and creating scheduling rules
• Using the Line Scheduling Workbench
• Rolling flow line schedules
• Synchronizing feeder lines
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OverviewOverview

Line sequencing and scheduling can avoid production that:Line sequencing and scheduling can avoid production that:
•• Is too slowIs too slow
•• Is too fastIs too fast
•• Is overloaded and does not have  enough resourcesIs overloaded and does not have  enough resources
•• Is idle and has too many resourcesIs idle and has too many resources

Overview of Line Scheduling
Flow Manufacturing uses production lines and rate-based schedules instead of
work orders to control production. Production occurs on lines that have been
designed and balanced to synchronize your activities and customer demand.
Line scheduling does the following:
•  Sequences and schedules sales orders from Oracle Order Management and
  planned orders from Oracle Planning to the line capacity. You can create
  flow schedules that represent a volume and mix of products.
•  Synchronizes production to customer demand, and establishes a realistic
  pace and flow of products throughout your production and supply chain.
•  Provides WIP schedulers the ability to plan, simulate, and schedule the
  production lines using the Line Scheduling workbench.
Prerequisites to Line Scheduling
•  Flow routings are fully developed.
•  In order to use sales orders, Oracle Order Management is in place.
•  In order to use planned orders, Oracle Advanced Planning and Scheduling
  (APS), Master Production Scheduling (MPS), or Material Requirements
  Planning (MRP) is in place.
•  Production lines are designed and balanced.
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• Defining and creating scheduling rules
• Using the Line Scheduling Workbench
• Rolling flow line schedules
• Synchronizing feeder lines
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Scheduling RulesScheduling Rules

Fix the problem!

Definition and Business Process
Scheduling rules contain the logic used to set the sequence and quantity for the
flow schedules. The rule is composed of the criteria used to sequence the orders
and an algorithm that determines how much of each item to schedule each day.
This logic helps you to pull your demand forward or backward in time in order
to meet takt for the current day. Several types of scheduling rules are provided
with Oracle Flow Manufacturing. You can define a unlimited number of rules
that pertain to all organizations.

Types of Rules
•  Predefined rules: Predefined scheduling rules combine one sequencing
  criterion and a system algorithm. Five predefined rules are provided. They are
  listed on the following page.
•  System definition-type rules: These are user-defined scheduling rules that
  you create by combining one or more of the system-provided sequence
  criteria with a system-provided algorithm.
•  User definition-type rules: You can also create your own rules by modifying
  the custom line scheduling procedure that is executed at the time of scheduling
  flow lines.
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Rule Name
Mixed Model

Level Daily Rate

Request Date
Schedule Date

Promise Date

Algorithm
Mixed Model

Level Daily Rate

No Level Loading
No Level Loading

No Level Loading

Sequencing Criterion
Order Request Date

Order Request Date

Order Request Date
Order Schedule Date

Order Promise Date

Predefined Scheduling RulesPredefined Scheduling Rules

(Help) Oracle Flow Manufacturing > Line Scheduling Workbench >
Defining Scheduling Rules
Note: Further discussion follows.
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Sequencing CriteriaSequencing Criteria

PlannedPlanned
ordersorders

SalesSales
ordersorders

Sequencing Flow Schedules
Flow schedules can be sequenced on one or more of the following criteria. The
sequence in which you enter your selections determines the order of priority:
•  Order Entry Date
•  Order Priority
•  Order Promise Date
•  Order Request Date
•  Order Schedule Date

Considerations
For unscheduled planned orders, the generated planned order due date is the
only criterion used for sequencing.
If you do not select a sequencing criterion, the system defaults to the sales order
schedule date or to the planned order suggested due date.
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Scheduling AlgorithmsScheduling Algorithms

Scheduling algorithms are used in conjunction with
sequencing criteria to create scheduling rules. The
three seeded algorithms are:
•  No Level Loading
•  Level Daily Rate
•  Mixed Model

Scheduling algorithms are used in conjunction with
sequencing criteria to create scheduling rules. The
three seeded algorithms are:
•  No Level Loading
•  Level Daily Rate
•  Mixed Model

(Help) Oracle Flow Manufacturing > Line Scheduling Workbench >
Defining Scheduling Rules > Scheduling Algorithms
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No Level Loading AlgorithmNo Level Loading Algorithm

• Protects production from volume variation
• Schedules to line rate
• Sequence based on criteria

• Protects production from volume variation
• Schedules to line rate
• Sequence based on criteria

Definition and Business Process
Flow schedules are sequenced according to the designated sequencing criteria,
and the demand is placed in the days of the scheduling horizon. Starting with
the first available day, demand is scheduled until capacity is reached.
The sequencing criteria determines the sequence of the flow schedules.
Beginning with the sales order line with the lowest sequence (or highest
priority), the order lines are scheduled in ascending order.  This preserves
capacity for future orders.
If you select a scheduling rule that uses the No Level Loading algorithm, the
criterion defined in the scheduling rules is used to prioritize and sequence the
orders. Orders are scheduled with capacity considerations beginning with the
first available date of the scheduling date range. If the entire quantity of the
sales order cannot be satisfied on a date, the remaining quantity is scheduled on
subsequent days where capacity is available.
This rule protects production from volume variation by scheduling only up to
the daily line rate. Any demand exceeding that rate is scheduled for the
following day. Therefore this rule is based on the finite capacity in the factory.
It sequences orders (sales orders or planned production orders) based on the
defined criteria.
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Day 1

Available
capacity

800 units/day

Day 2

Available
capacity

800 units/day

Day 3

Available
capacity

800 units/day

Day 4

Available
capacity

800 units/day

No Level Loading AlgorithmNo Level Loading Algorithm

Example
There are three unscheduled booked sales orders that fall within the selection
criteria for creating a flow schedule.
Sales Order Item Quantity Request Date
1001 Widgets 1000 Day 1
1002 Gadgets  750 Day 2
1003 Devices  500 Day 3
The sequence criterion specifies Request Date. The sales orders are sequenced
in that order, as shown in the table.
The Daily Line Rate is 800 units per day (as defined in the Production Line
setup).
In the No Level Loading algorithm, demand mix is not considered. The orders
are lined up to be built in request date sequence.
Sales order 1001:

•  The order quantity is for 1000 widgets.
•  The available capacity on day 1 is 800 units.
•  A quantity of 800 widgets is scheduled for day 1. The remaining quantity
  to be scheduled is 200.
•  The available capacity on day 2 is 800 units.
•  The remaining quantity of 200 widgets is scheduled for day 2. After sales
   order 1001 is complete, the remaining capacity on day 2 is 600.
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Day 1

S. O. 1001
800 widgets

Day 2

S. O. 1002
600 Gadgets

S. O. 1001
200 Widgets

Day 3

Available
capacity

S. O. 1003
500 devices

S. O. 1002
150 gadgets

Day 4

Available
capacity

No Level Loading AlgorithmNo Level Loading Algorithm

Sales orderSales order ItemItem QuantityQuantity
10011001 Widgets             1000Widgets             1000
10021002 GadgetsGadgets    750   750
10031003 DevicesDevices    500   500

Example (continued)
Sales order 1002:

•  The order quantity is 750 gadgets.
•  Available capacity on day 2 is 600 units.
•  A quantity of 600 gadgets is scheduled on day 2. The remaining quantity
   to be scheduled is 150.
•  The available capacity on day 3 is 800 units.
•  The remaining quantity of 150 gadgets is scheduled for day 3. After sales
   order 1002 is complete, the remaining capacity on day 3 is 650.

Sales order 1003:
•  The order quantity is 500 devices.
•  The available capacity on day 3 is 650 units.
•  The entire quantity of 500 devices is scheduled on day 3. After sales
   order 1003 is complete, the remaining capacity on day 3 is 150, and the
   available capacity on day 4 is 800 units.
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Level Daily Rate AlgorithmLevel Daily Rate Algorithm

• Protects production from volume and mix variation
• Minimizes setup
• Considers demand ratio of the item

(demand for item/demand for family)
• Schedules to demand daily ratio
• Schedules to line rate
• Sequence based on criteria

• Protects production from volume and mix variation
• Minimizes setup
• Considers demand ratio of the item

(demand for item/demand for family)
• Schedules to demand daily ratio
• Schedules to line rate
• Sequence based on criteria

Definition and Business Process
If you choose to schedule your line using the Level Daily Rate, each item is
scheduled at a rate in regard to the demand ratio of the item. The demand ratio
of an item equals the total demand for the item divided by the grand total
demand. It is multiplied by each day’s available capacity to determine how
much of an item will be scheduled every day.
Within a day, all of the same product are scheduled sequentially, thereby
minimizing setup on the shop floor.
This rule protects production from volume variation by scheduling only up to
the daily line rate. Any demand exceeding that rate is scheduled for the
following day. Therefore this rule is based on the finite capacity in the factory.
This rule reduces  mix variation by spreading the mix evenly across the
scheduling horizon based on demand ratio.
Level Daily Rate sequences orders (sales orders or planned production orders)
based on the defined criteria.
On planned order types only, order modifiers can be used to define the quantity
of flow schedules.
The day’s demand for an item is built consecutively at one time during the day.
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Level Daily Rate AlgorithmLevel Daily Rate Algorithm

Day 1

Available
capacity

800 units/day

Day 2

Available
capacity

800 units/day

Day 3

Available
capacity

800 units/day

Day 4

Available
capacity

800 units/day

Example
There are three unscheduled booked sales orders that fall within the selection
criteria for creating a flow schedule.
Sales Order Item Quantity Request Date
1001 Widgets 1000 Day 1
1002 Gadgets  750 Day 2
1003 Devices  500 Day 3
The sequence criterion specifies the request date. The sales orders are
sequenced in that order, as shown in the table.
The Daily Line Rate is 800 per day (as defined in the Production Line setup).
In the Level Daily Rate algorithm, demand mix is considered. The orders are
lined up according to the sequencing criterion and are built according to the
following demand ratio:
•  There are 2250 total units (1000 + 750 + 500).
•  The demand ratio for widgets is 44% (1000/2250).
•  The demand ratio for gadgets is 34% (750/2250).
•  The demand ratio for devices is 22% (500/2250).
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Day 1

S. O. 1003
176 devices

S. O. 1002
272 gadgets

S. O. 1001
352 widgets

Day 2

S. O. 1003
176 devices

S. O. 1002
272 gadgets

S. O. 1001
352 widgets

Day 3

Available
capacity

S. O. 1003
148 devices
S. O. 1002

206 gadgets
S. O. 1001

 296 widgets

Day 4

Available
capacity

Level Daily Rate AlgorithmLevel Daily Rate Algorithm

Sales orderSales order ItemItem QuantityQuantity
10011001 Widgets            1000Widgets            1000
10021002 GadgetsGadgets   750  750
10031003 DevicesDevices   500  500

Example (continued)
Day 1: Schedule each item to the calculated demand ratio, filling day 1 capacity.
•  Widgets = 0.44 × 800 = 352 (remaining to be scheduled = 1000-352 = 648)
•  Gadgets = 0.34 × 800 = 272 (remaining to be scheduled = 750 - 272 = 478)
•  Devices = 0.22 × 800 = 176 (remaining to be scheduled = 500 - 176 = 324)
Day 2: Schedule each item to the calculated demand ratio, filling day 2 capacity.
•  Widgets = 0.44 × 800 = 352 (remaining to be scheduled = 648 - 352 = 296)
•  Gadgets = 0.34 × 800 = 272 (remaining to be scheduled = 478 - 272 = 206)
•  Devices = 0.22 × 800 = 176 (remaining to be scheduled = 324 - 176 = 148)
Day 3: Schedule each item to the calculated demand ratio, scheduling day 3
capacity.
•  Widgets = 0.44 × 800 = 352, but only 296 remain to be scheduled
•  Gadgets = 0.34 × 800 = 272, but only 206 remain to be scheduled
•  Devices = 0.22 × 800 = 176, but only 148 remain to be scheduled
• Note: Remaining capacity for day 3 = 150 (800 - 296 - 206 - 148).
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Mixed Model AlgorithmMixed Model Algorithm

• Protects production from volume and mix variation
• Considers demand ratio of the item

(demand for item/demand for family)
• Schedules by unit quantities
• Schedules to line rate
• Sequence based on criteria

• Protects production from volume and mix variation
• Considers demand ratio of the item

(demand for item/demand for family)
• Schedules by unit quantities
• Schedules to line rate
• Sequence based on criteria

Business Process
Similar to the Level Daily Rate algorithm,  the Mixed Model algorithm
schedules production at a rate governed by the demand ratio of each item in
order to establish a production pattern for a mix of items.
The demand ratio is an item’s demand, divided by the demand for all items to
be scheduled within that scheduling horizon. It is multiplied by each day’s
available capacity to determine how much of an item will be scheduled every
day.
A sequencing pattern is developed based on the item’s demand ratio. The
pattern is run repeatedly throughout the day. A single item may therefore be
built several times in the same day.
This rule protects production from volume variation by scheduling only up to
the Level Daily Rate. Any demand exceeding that rate is scheduled for the
following day. It sequences orders (sales orders or production orders) based on
the defined criteria. Therefore this rule is based on the finite capacity in the
factory. It also minimizes mix variation by spreading the demand mix evenly
across the scheduling horizon, scheduling a repeated pattern of that mix within
each day.
Note: This rule always creates schedules in unit quantities regardless of the
order modifiers.
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Mixed Model AlgorithmMixed Model Algorithm

Day 1

Available
capacity

800 units/day

Day 2

Available
capacity

800 units/day

Day 3

Available
capacity

800 units/day

Day 4

Available
capacity

800 units/day

Example
Mixed Model calculations are performed in the same way as Daily Level Rate
calculations. The difference between these two algorithms is the pattern in
which the different items are built.
Sales Order Item Quantity Request Date
1001 Widgets 1000 Day 1
1002 Gadgets  750 Day 2
1003 Devices  500 Day 3
The sequence criterion specifies Request Date. The sales orders are sequenced
in that order.
When using the Mixed Model algorithm, a pattern is set based on the lowest
ratio.
1. You first determine the demand ratio.
•  The demand ratio for widgets is 44% (1000/2250).
•  The demand ratio for gadgets is 34% (750/2250).
•  The demand ratio for devices is 22% (500/2250).
• 2. You then take the lowest ratio at the unit level to establish the pattern. The
lowest ratio for widgets is 4; for gadgets 3; and for devices 2.
• Therefore the pattern is 4 widgets followed by 3 gadgets followed by 2 devices.
This pattern is repeated over and over throughout the day until the full line
capacity for each day has been used or until all units have been built.
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Day 1

up to 800
Units

2 devices
then
3 gadgets,
then
4 widgets,

Day 2

up to 800
units

2 devices
then
3 gadgets,
then
4 widgets,

Day 3

Available
capacity
up to 650

units
2 devices
then
3 gadgets,
then
4 widgets,

Day 4

Available
capacity

Mixed Model AlgorithmMixed Model Algorithm

Sales orderSales order ItemItem QuantityQuantity
10011001 Widgets            1000Widgets            1000
10021002 GadgetsGadgets   750  750
10031003 DevicesDevices   500  500

Example (continued)
The resulting mix is that on days 1 and 2, four widgets are assembled, then three
gadgets are assembled, and finally two devices are assembled until the line
capacity of 800 items is reached.
On day 3 the same mix is assembled, but only until 650 units is reached, which
is the entire demand for the three items, resulting in the available capacity of
150 units.
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Level Daily Rate versus Mixed Model
Algorithm

Level Daily Rate versus Mixed Model
Algorithm

The aggregate answer is the same.The aggregate answer is the same.The aggregate answer is the same.

versusversus

Comparing Level Daily Rate with Mixed Model Scheduling
Because both of these algorithms are based on demand ratio, the aggregate
answer is the same.
The difference between the two is that in Level Daily Rate, a day’s worth of
widgets is built one after the other, with no other item built in between. In
Mixed Model Scheduling, a pattern of products is built in sequence, and the
same item can be built many times during the day, with other items built in
between.  If the work content of the two items is different at various operations,
the Level Daily Rate rule will produce a schedule that creates imbalances, the
Mixed Model rule will tend to minimize this type of imbalance.
Mixed Model scheduling approaches a Flow Manufacturing goal of a lot size of
one, but it requires more changeovers and sequencing control. You must decide
what is most critical to your business.
Note: The line schedule assigns a build sequence for every item or quantity
when using the Mixed Model scheduling algorithm. This results in the need to
report production for each build sequence in order to relieve the line schedule of
the load.
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Wrong Product MixWrong Product Mix

Wrong Product Mix Considerations
If the product’s demand ratio varies considerably from its allocation during line
design, the kanban sizes may be understated and temporarily burdened during
production. Additionally, some operations on the line may be idle while others
may be over-burdened. If you saved the line design mixed model map as a
baseline, you can run the Mixed Model Map against actual production and
compare it to your baseline.
Any of the following situations can indicate a wrong mix:
•  Kanbans that must be replenished more frequently than anticipated
•  Kanbans that seldom need to be replenished, but are taking up valuable
  production area
•  Material runners that are too busy to keep up with all the kanbans
•  Material runners that are idle too often
•  Production workers who are idle at specific operations
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Defining Scheduling RulesDefining Scheduling Rules

Use the Defining Scheduling Rules window to
complete your user-defined scheduling rule.

Manufacturing and Distribution Manager Responsibility

Flow Manufacturing (N) Setup > Scheduling Rules

How to View the Existing Rules
1. Select Query by Example from the View menu.
2. Select Enter from the drop-down list.
3. Enter a % in the Name field.
4. Press [Ctrl]+[F11] to execute the query. The first existing rule is
    displayed. It may be one of the seeded rules or your own defined rule.
5. Click Page Down to view the next existing rule.

How to Create User-Defined Rules
To define your own rules, enter the following information:
1. Name: User-defined.
2. Description: User-defined.
3. Enabled check box: Specifies whether this rule is in effect.
4. Default check box: Specifies whether this rule is the default rule. The
    default rule is used unless you override it. There can be only one default
    rule for scheduling.
(Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >

   Line Scheduling Workbench > Defining Scheduling Rules
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Defining Scheduling RulesDefining Scheduling Rules

Can I use one of the three
seeded algorithms, or do I
need to create my own?

How to Create User-Defined Rules (continued)
5. Definition Type option buttons:

• System: Select this option button to create a rule using a system-
provided algorithm and sequencing criteria.
• User: Select this option button to create a rule to meet more complex
 requirements, which are defined by a user procedure. You enter the
 name of your procedure in the Name field.

6. Leveling: For system type rules only, select one of the system-provided
    algorithms from the drop-down list.
7. Criteria Name: For system type rules only, select one or more values from
    the drop-down list. These values are to be selected in the order of their
    priority.
8. Criteria Order: System generated in the order in which you made your
    selection from the Criteria Name drop-down list.
9. Save your work.
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Practice LS-1Practice LS-1

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Create a scheduling rule named nn-Rule that is used to
    schedule sales orders
Note: All organization assignments are for M1, Seattle Manufacturing

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Create a scheduling rule named nn-Rule that is used to
    schedule sales orders
Note: All organization assignments are for M1, Seattle Manufacturing

1. Create a Scheduling Rule
(N) Flow Manufacturing > Setup > Scheduling Rules
Enter Your Scheduling Rule
1. Navigate to the Define Scheduling Rules window.
2. Enter a name and description for your scheduling rule.
3. Leave the ‘Enabled’ and ‘System’ options checked.
4. Select Level Daily Rate from the Leveling drop-down list.
5. In the Criteria Name area, select the following priority sequence from the
   drop-down list:

•  Order Entry Date
•  Order Priority

6. Save your work.
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• Overview
• Defining and creating scheduling rules
• Using the Line Scheduling Workbench
• Rolling flow line schedules
• Synchronizing feeder lines

• Overview
• Defining and creating scheduling rules
• Using the Line Scheduling Workbench
• Rolling flow line schedules
• Synchronizing feeder lines
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Line Scheduling WorkbenchLine Scheduling Workbench

New or revisedNew or revised
flow schedulesflow schedules

Current statusCurrent status

Overview
Schedulers use the Line Scheduling workbench to create and manage flow
schedules and to simulate the assignment of work to production lines that
schedule work on specific lines. Although you can view all scheduled orders
(such as discrete jobs, repetitive schedules, and flow schedules) through the
workbench windows, you can only create and schedule a flow schedule.
You can perform a work order-less assembly completion against a flow
schedule previously created and scheduled either manually or by using the Line
Scheduling workbench. When performing the Work Order-less Completions
transaction, you can select from a list of flow schedules that are scheduled to
complete on that particular day.
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Functions of the
Line Scheduling Workbench

Functions of the
Line Scheduling Workbench

Viewing and Maintaining Flow SchedulesViewing and Maintaining Flow Schedules

Rolling Flow SchedulesRolling Flow Schedules

Creating Flow SchedulesCreating Flow Schedules

Viewing Unscheduled OrdersViewing Unscheduled Orders

Functionality
The Line Scheduling Workbench Options window is the interface to the other
flow scheduling windows. The available functions in all windows are:

•  Viewing unscheduled orders: You can view unscheduled orders in the
  Unscheduled Orders window. You can display either unscheduled
  planned orders or sales orders. These unscheduled orders can be
  converted into flow schedules.
•  Creating flow schedules: You can create flow schedules from sales orders
   or planned orders using your scheduling rules.
•  Viewing and maintaining flow schedules: You can view and modify
   schedule quantities and dates of flow schedules.
•  Rolling flow schedules: You can roll flow schedules forward, based on
  under-completions and over-completions, in order to adjust future
  production.

(Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >
Line Scheduling Workbench >
Overview of Line Scheduling in Flow Manufacturing
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Functions of the
Line Scheduling Workbench

Functions of the
Line Scheduling Workbench

Viewing the Resource Load GraphViewing the Resource Load Graph

Deleting Flow SchedulesDeleting Flow Schedules

Performing Flow Schedule CompletionPerforming Flow Schedule Completion

Using the Mixed Model MapUsing the Mixed Model Map

Checking Component AvailabilityChecking Component Availability

Functionality (continued)
•  Checking component availability: You can view component availability
   in the ATP Results window.
•  Viewing the resource load graph in relationship to available capacity:
   You can view a graphical representation of the required load of the line
   and its associated resources.
•  Deleting flow schedules: You can delete flow schedules in order to
  provide a clean slate for new schedule generation.
•  Performing flow schedule completion: You can perform completion
  transactions for scheduled flow schedules when production is finished.
•  Using the mixed model map: You can open the Mixed Model Map
  window from the workbench. You use this window to monitor your
  resource requirements against the scheduled production.
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Viewing Unscheduled OrdersViewing Unscheduled Orders

Unscheduled sales orders for the Desktops flow line

Assembly    Order Date       Unscheduled Qty       Qty to Schedule

MC31749      22/FEB/2001 00:00:00           100                              100

MC31749      23/MAR/2001 00:00:00            10                                10

Manufacturing and Distribution Manager Responsibility

Flow Manufacturing (N) Line Scheduling > Scheduling Workbench
(B) Unscheduled Orders

Searching for Unscheduled Orders
1. In the Line Scheduling Workbench Options window, you can either accept
    the default values displayed in the Unscheduled Orders region or you can
    select an order type and enter the corresponding dates in that region.
2. Click the Unscheduled Orders button. The Find Unscheduled Orders
    window is displayed.
3. Enter your search criteria: Field, Condition, From, and To.
4. Click the Find button to open the Unscheduled Orders window. All
    unscheduled orders for the selected type with a schedule date within your
    selected date range are displayed.
Note: If you implement any orders from this window, their scheduling rules are
ignored. The orders are scheduled for their date regardless of the line’s capacity.
(Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >

   Line Scheduling Workbench > Viewing Unscheduled Orders
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Creating Flow SchedulesCreating Flow Schedules

Use the Scheduling Workbench window to complete:
• Order Type

• Order Dates

Manufacturing and Distribution Manager Responsibility

Flow Manufacturing (N) Line Scheduling > Scheduling Workbench

Creating a Flow Schedule
1. Select the order type you want to schedule, either sales or planned.
2. For Order Dates, enter the date range of the orders you want to schedule.
3. Optionally enter a schedule group. This is similar to a category of
    schedules.
4. Select the appropriate rule from the Scheduling Rules drop-down list.
5. Enter a date range into which you want to schedule the orders to complete.
6. Select the Create Flow Schedules button. Upon completion, the Flow
    Schedule Summary window is displayed with the resulting schedules.
7. To view if any orders within your selected date range were not scheduled,
    select the Unscheduled Orders button. If there are orders displayed that fit
    within your selected range, this can be due to insufficient line capacity.
(Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >

   Line Scheduling Workbench >
   Viewing, Creating, and Modifying Flow Schedules >
   Creating Flow Schedules
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Creating Flow SchedulesCreating Flow Schedules

Do not Schedulex

Consideration
By selecting Do Not Schedule from the Scheduling Rules drop-down list, you
can bypass the use of a scheduling rule. This option uses the schedule date on
your orders without regard to any rule or line capacity. You can use this option
either to implement planned orders that have been optimized by APS or to
schedule sales orders as they are.
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Practice LS-2Practice LS-2

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Add your finished good items to the CORPORATE
price list

2. Create a sales order for products nn-M1 and nn-M2

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Add your finished good items to the CORPORATE
price list

2. Create a sales order for products nn-M1 and nn-M2

1. Add items to the CORPORATE price list
(N) Order Entry > Pricing > Price Lists > Price List Setup
Select the CORPORATE price list and select the icon to add new entries.
•  Add item nn-M1 with a price of $1.00
•  Add item nn-M2 with a price of $2.00
•  Save your work.
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Practice LS-2Practice LS-2

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

2. Create a sales order for products nn-M1 and nn-M2

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

2. Create a sales order for products nn-M1 and nn-M2

2. Enter a Sales Order for Your Master Items
(N) Order Entry > Orders, Returns > Sales Orders
Select the Order Information tab and then the Main tab and enter the following
standard order header information:

•  Customer Number: 1000 (Business World)
•  Order Type: Standard
•  Customer PO: nn
•  Price List: CORPORATE
•  Others tab

– Warehouse: W1
•  Save your work.
•  Select the Lines tab.

Note: Record your order number:__________________________
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Practice LS-2Practice LS-2

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

2. Create a sales order for products nn-M1 and nn-M2

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

2. Create a sales order for products nn-M1 and nn-M2

Enter a Sales Order for Your Master Items
Select the Line Items tab and enter the following sales order line item data:

1. Line 1: Item nn-M1, for a quantity of 100, from warehouse M1
Note: Set the request date for two weeks from today.

2. Line 2: Item nn-M2, for a quantity of 200, from warehouse M1
Note: Set the request date for two weeks from today.

3. Schedule the order.
Note: Record your request date:___________________________

4. Book your order.
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Practice LS-3Practice LS-3

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Use the Line Scheduling workbench to view
unscheduled orders

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Use the Line Scheduling workbench to view
unscheduled orders

1. View Your Unscheduled Sales Order
(N) Flow Manufacturing > Line Scheduling > Scheduling Workbench
1. For your nn-LINE flow line, set the order date equal to the request date of
    your sales order.
2. Set the scheduling rule to your nn-RULE.
3. Set the schedule dates from today for a total of three days.
4. Click the Unscheduled Orders button.
5. Click the Find button in the Find Unscheduled Orders window.
Note: Your master items and the assigned order number that you recorded
earlier are displayed. If they are not, exit the form and recheck the data that you
entered.
6. Close the form and return to the Line Scheduling Workbench Options
    window.
Note: Do not press the Implement button.
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Practice LS-4Practice LS-4

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Use the Line Scheduling workbench to create flow
    schedules

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Use the Line Scheduling workbench to create flow
    schedules

1. Schedule Your Sales Order
(N) Flow Manufacturing > Line Scheduling > Scheduling Workbench
1. For your nn-LINE flow line, set the order date equal to the request date of
    your sales order.
2. Set the scheduling rule to your nn-RULE.
3. Set the schedule dates for one week from today for a total of three days.
4. Click the Create Flow Schedules button.
5. Navigate to the Flow Schedule Summary window.
Question: Why was the order quantity for nn-M1 master item split into 27, 27,
and 26?
____________________________________________________________
6. Save your work.
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Viewing and Maintaining Flow SchedulesViewing and Maintaining Flow Schedules

Use the Scheduling Workbench window to complete:
• Scheduled Date

Manufacturing and Distribution Manager Responsibility

Flow Manufacturing (N) Line Scheduling > Scheduling Workbench
(B) Flow Schedule Summary

Business Process
You can view your flow schedules in summary form. You can also create and
maintain them at this level, but only if they do not have details such as schedule
group, project, or task.
Note: All discrete jobs and repetitive schedules are also displayed. However,
you can only view them; you cannot update them.

Displaying the Summary Schedule
1. In the Line Scheduling Workbench Options window, in the Scheduled
   Date field, enter the date of the flow schedule that is to be displayed.
Note: The schedule that is first displayed is for the week that contains the date
you entered. The date you enter cannot be earlier than today.
2. Click the Flow Schedule Summary button.
(Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >

   Line Scheduling Workbench >
   Viewing, Creating, and Modifying Flow Schedules >
   Flow Schedule Summary Window
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How to Display the Summary ScheduleHow to Display the Summary Schedule

looking at next week’s schedule:
• what’s planned?
• what’s completed?
• is there a variance?

Displaying the Summary Schedule (continued)
The Flow Schedule Summary window displays the schedules in a bucketed
format beginning with the first day of the week. In this window you can scroll
backward and forward to view the schedules.
You can control the quantity types that are displayed by selecting Preferences
from the Tools menu. The available quantity types are:

•  Planned: The quantity calculated when you created the flow schedule.
•  Completed: The quantity reported when you performed a completion on
  this schedule.
•  Variance: The difference between the Planned and Completed quantities
   calculated by the system.
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Assembly Type Total 08/JAN/2001 09/JAN/2001
MC24713 Planned 250 125 125

Completed 248 124  124

Variance     2     1     1

MC97160 Planned   50   25    25

Completed   27    1    26

Variance   23  24     -1

             Total Planned  300 150 150

 Total Completed 275 125 150

Total Variance   25  25     0

Displaying the Summary Schedule (continued)
You can modify the planned quantity either in the Total column or in specific
date columns. Entering a quantity in the Total column triggers the system in
spreading weekly quantities across the valid workdays.
The Total and Total Planned Quantity fields for the assembly always reflect the
changes that you make.
In the example in the slide, the planned quantity in the Flow Schedule Details
window for assembly MC97160 for 08/JAN/2001 was changed from 25 to 125.
This change is reflected in the Total column as well as in the column for that
specific date in the Flow Schedule Summary window.
From this window you can:

•  Navigate to the Unscheduled Orders window
•  View the capacity profile at the line level for individual resources for the
   flow schedule selected
•  Navigate to the Flow Schedule Details window for one or multiple
   assemblies
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Viewing the Details of a Flow ScheduleViewing the Details of a Flow Schedule

Use the Scheduling Workbench window to complete:
• Scheduled Date

Manufacturing and Distribution Manager Responsibility

Flow Manufacturing (N) Line Scheduling > Scheduling Workbench
(B) Flow Schedule Summary (B) Details

Flow Schedule Details
(Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >

   Line Scheduling Workbench >
   Viewing, Creating, and Modifying Flow Schedules >
   Flow Schedule Details Window
Business Process

From the Flow Schedule Summary window, you can navigate to the Flow
Schedule Details window and view or modify your flow schedules at the detail
level.

How to View the Schedule Details
1. From the Line Scheduling Workbench Options window, select the desired
    schedule dates.
2. Select the Flow Schedule Summary button.
3. Select your items.
4. Click the Details button.
Note: All discrete jobs and repetitive schedules are also displayed. You can only
view them at this level; you cannot update them. You can view the order type
by using the Folder tools on the tool bar.
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Practice LS-5Practice LS-5

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. View line schedule details

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. View line schedule details

1. View Line Schedule Details
(N) Flow Manufacturing > Line Scheduling > Scheduling Workbench
1. For your nn-LINE flow line, set the schedule dates equal to one week from
    today.
2. Click the Flow Schedule Summary button.
3. Choose Select All from the Edit menu.
4. Navigate to the Flow Schedule Details window.
5. Verify the build sequence numbers, order numbers, and line numbers.
Question: What date range are the assemblies scheduled for?
 From____________________ To_____________________
Note: These dates are used in the next practice.
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• Overview
• Defining and creating scheduling rules
• Using the Line Scheduling Workbench
• Rolling flow line schedules
• Synchronizing feeder lines

• Overview
• Defining and creating scheduling rules
• Using the Line Scheduling Workbench
• Rolling flow line schedules
• Synchronizing feeder lines
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Rolling Flow SchedulesRolling Flow Schedules

Use the Roll Flow Schedules Parameters window to
complete:

• Quantities parameter options
• Report options

Manufacturing and Distribution Manager Responsibility

Flow Manufacturing (N) Line Scheduling > Scheduling Workbench
(M) Tools > Roll Flow Schedules

Roll Flow Schedules Parameters
   (Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >
   Line Scheduling Workbench > Line Scheduling Tools Menu >
   Roll Flow Schedules

Flow schedules must be maintained to keep the production schedule information
and planning information current. Note: MRP calculations do not consider flow
schedules with past due dates. You can use the Roll Flow Schedules window to
update your flow schedules to keep your MRP accurate. The Roll Flow
Schedules program is designed to assist you to adjust future schedules based on
actual past performance. You can adjust the quantity on future production
schedules based on the completion quantities. You can change schedules for a
line, for a range of lines, or for all lines at once.
Rolling flow schedules forward adds undercompletion quantities to the schedule
and subtracts overcompletion quantities from the schedule. The past planned
quantities are not reduced or increased. They are maintained for linearity
reporting.
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Roll Schedule Example: UndercompletionRoll Schedule Example: Undercompletion

After rolling forward

Scheduled

Completed

Variance

Original 
scheduled quantity

01/08/00 01/15/00 01/08/00 01/15/00

20 20 20

20

10

10

0 10

10

30
0

30

A quantity of 10 was not completed in the 01/08/00 schedule.A quantity of 10 was not completed in the 01/08/00 schedule.

After the roll forward, the planned quantity for the 01/15/00After the roll forward, the planned quantity for the 01/15/00
schedule was schedule was increasedincreased  from 20 to 30.from 20 to 30.

Roll Flow Schedules Program (continued)
Considerations
Two parameter options are available for spreading the quantities:
•  Spread Quantities Evenly: The production quantity is spread evenly over
  your specified date range, beginning with the first day of the specified
  range.
•  Do Not Spread Quantities: Each date is filled to capacity.
Report Options
•  Report Only: Creates a report but does not update your flow schedules.
   Use this option to simulate the effects on your schedule.
•  Report and Update: Creates a report and rolls the dates forward on your
   schedules.
Note: If you roll the same flow schedules multiple times, it is possible to create
excess supply. Flow schedules with past or current dates are used in the process
of rolling schedules to a future date.
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Roll Schedule Example: OvercompletionRoll Schedule Example: Overcompletion

The 01/08/00 schedule was overcompleted by a quantity of 10.The 01/08/00 schedule was overcompleted by a quantity of 10.

After the roll forward, the planned quantity for the 01/15/00After the roll forward, the planned quantity for the 01/15/00
schedule was schedule was reducedreduced from 20 to 10. from 20 to 10.

After rolling forward

Scheduled

Completed

Variance

Original 
scheduled quantity

01/08/00 01/15/00 01/08/00 01/15/00

20 20 20

20

30

-10

0 30

-10

10
0

10

Note: The scheduled quantity is not adjusted by the overcompletion if a build
sequence number or order information exists for the schedule. In this case the
original quantity of 20 scheduled for 01/15/00 remains at 20 if the information
is present in the Flow Schedule Details window.
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Let’s see the load
against capacity!

Are the
components
available?

Other Features
Checking Component Availability

   (N)Flow Manufacturing > Line Scheduling > Line Scheduling Workbench >
   Flow Schedule Summary (B) Details (B) Component Availability
   (Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >
   Line Scheduling Workbench > Other Features > Component Availability

You can access Available To Promise information through the ATP Results
window and view the status of material used on your flow schedules. The
components for each flow schedule are listed individually on separate rows.
Note: Only those components whose Check ATP attribute is set to Yes are
displayed.
Graphical Data Display in Relationship to Capacity

   (N) Flow Manufacturing > Line Scheduling > Line Scheduling Workbench >
   Flow Schedule Summary (B) Capacity Graph
   (Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >
   Line Scheduling Workbench > Other Features > Viewing Load and Capacity

You can view the capacity profile at the line level prior to scheduling your flow
schedules. The graph display shows the load by item for the line and its
resources. The capacity is based on the routings for the assemblies scheduled on
the selected dates.
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• Deleting Flow Schedules
• Performing Flow Schedule Completions
• Using the Mixed Model Map

• Deleting Flow Schedules
• Performing Flow Schedule Completions
• Using the Mixed Model Map
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• Overview
• Defining and creating scheduling rules
• Using the Line Scheduling Workbench
• Rolling flow line schedules
• Synchronizing feeder lines

• Overview
• Defining and creating scheduling rules
• Using the Line Scheduling Workbench
• Rolling flow line schedules
• Synchronizing feeder lines
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Feeder Line SynchronizationFeeder Line Synchronization

Feeder line scheduleFeeder line schedule
products X, Y, and Zproducts X, Y, and Z

Main flow line scheduleMain flow line schedule
products A, B, and Cproducts A, B, and C

Definition and Business Process
   (Help) Oracle Manufacturing Applications > Oracle Flow Manufacturing >
   Line Scheduling Workbench > Other Features >
   Feeder Line Synchronization

With Flow Manufacturing you can create schedules for subassemblies that are
directly derived from parent assembly line schedules. You can specify a line, or
range of lines, and a date range as input. These subassembly feeder lines use
sequence information from the parent assembly schedules to synchronize their
production.
Benefits
•  With a synchronized feeder line schedule, you can control the sequences of
   subassemblies produced on the feeder line in support of customer demand.
•  You can support complex mass customization environments.
•  Kanban and in-process kanban inventory can be reduced.
• Setup
• This functionality relies on:
•  Existing multilevel bills of material
•  Flow routings for nonphantom subassemblies
•  Feeder line completion date equal to primary line start date
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Use the Scheduling Workbench window to complete:
• From and To Flow Line(s)

• From and To Dates

Manufacturing and Distribution Manager Responsibility

Flow Manufacturing (N) Line Scheduling > Scheduling Workbench
(B) Flow Schedule Summary

Submitting Your Request for Synchronization
•  Fill out the parameters for your selected flow line and schedule dates.
•  Submit your request.
• Note: The From Line and To Line parameters refer to the range of parent lines
you are synchronizing. The From Date and To Date parameters refer to the
range of start dates for schedules of your selected parent lines.
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Practice LS-6Practice LS-6

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Create a sub-assembly and feeder line.
2. Synchronize a feeder line for sub-assembly
    production.

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Create a sub-assembly and feeder line.
2. Synchronize a feeder line for sub-assembly
    production.

1. Create a Sub-assembly and Feeder Line
1. Create a new sub-assembly item, nn-M3.

•  Description: nn Sub Item M3, Flow Subassembly
•  Copy from template: Subassembly

2. Assign to organization M1.
3. Update the lead time and variable lead time on the organizational item nn-M1
    to the TPCT time and line TAKT respectively. Express the times as decimal
    portions of the work day (0.078 lead time; 0.025 variable lead time).
4. Create a bill of material for your nn-M3 sub item, where its component is
    nn-KB1, for a quantity of 1, in subinventory RIP.
5. Update your master item nn-M1 bill of material.

•  Add component nn-M3 for a quantity of 1, in subinventory RIP
•  Assign it to the third operation sequence number (30).

6. Create a new production line, nn-LINE2, using the same data as your nn-
LINE.
7. Create one standard event, one process, and one line operation.
8. Create a flow routing for your nn-M3 master item on your nn-LINE2.
Note: Make sure that there is at least one resource with scheduled time.
9.  Calculate operation times and total product cycle times.
10. Save your work.
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Practice LS-6Practice LS-6

Instructions
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you will learn how to:

1. Create a subassembly and feeder line.
2. Synchronize a feeder line for sub-assembly
    production

Instructions
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you will learn how to:

1. Create a subassembly and feeder line.
2. Synchronize a feeder line for sub-assembly
    production

2. Synchronize a Feeder Line for sub-assembly production
Feeder line synchronization allows you to create schedules for feeder flow lines
that are directly derived from parent assembly line schedules. This makes it
possible for you to synchronize the production of feeder lines with final
assembly lines. This synchronization also allows material to be produced when
needed at final assembly without requiring buffer inventories.
(N) Flow Manufacturing > Line Scheduling > Feeder Line Synchronization
Note: The Parameters window is displayed.
1. Enter your nn-LINE flow line in the From Line and To Line fields.
2. In the Date range, enter today’s date and the last scheduled date for your
    nn-M1 master item from the previous practice.
3. Submit your request.
4 .Navigate to the Line Scheduling workbench.
(N) Flow Manufacturing > Line Scheduling > Scheduling Workbench
5. For your nn-LINE2 flow line, change the schedule date to one week from
    today and click the Flow Schedule Summary button.
6. Verify the build sequence numbers of your nn-M3 master item detail
    records.
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Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Use the Line Scheduling workbench to create flow
schedules from planned orders

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Use the Line Scheduling workbench to create flow
schedules from planned orders

Create Planned orders from MRP
(N) Material Planning > MDS > Names
1. Create an MDS schedule, nn-MDS.
2. Create MDS entries for your items as follows:
Item                 Quantity         Date
nn-M1 100 1 week + 3 days
nn-M2 200 1 week + 3 days
3. Save your work.
4. Create an MPS plan, nn-MPS.
(N) Material Planning > MPS > Names
Note: Ensure that your nn-M1 and nn-M2 items are set for MPS planning.
5. Click the Production checkbox.
6. Set the demand schedule to your nn-MDS schedule. Select ‘Demand
scheduled items only’ for planned items.
7. Save your work.
8. Launch your MPS plan.
Note: Record your request number__________________________
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Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Use the Line Scheduling workbench to create flow
schedules from planned orders

Instructions:
Using the following information, perform the setup.
Replace nn with your initials.
In this practice, you learn how to:

1. Use the Line Scheduling workbench to create flow
schedules from planned orders

Schedule Your Plan
(N) Flow Manufacturing > Line Scheduling > Scheduling Workbench
1.For your nn-LINE flow line, set the order type to Planned Orders and the
   order dates to the due date of your MDS entries.
2. Set the Scheduling Rule to you nn-RULE.
3. Set the Schedule Dates from today for a total of 3 working days.
4. Select the Create Flow Schedules button.
5. Navigate to the Flow Schedule Summary window.
Question: Why was the order quantity for nn-M1 master item split into

27, 27, and 26?
_______________________________________________________________
6. Save your work.
Select the Unscheduled Orders button. Because the planned order quantities are
greater than the line capacity, there remains some unscheduled quantities for
your master items.
Question: What quantity remains unscheduled for your nn-M1 item?
 _______________
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• You can use seeded algorithms and sequencing
criteria to create your scheduling rules; or,
because the system is extensible, you can specify
a custom procedure to sequence complex
problems.

• You can manage your line schedules through the
Line Scheduling workbench. With the workbench,
you can:
– View unscheduled orders
– Create, view, and maintain flow schedules
– Check component availability

• Derive schedules for feeder lines from parents

• You can use seeded algorithms and sequencing
criteria to create your scheduling rules; or,
because the system is extensible, you can specify
a custom procedure to sequence complex
problems.

• You can manage your line schedules through the
Line Scheduling workbench. With the workbench,
you can:
– View unscheduled orders
– Create, view, and maintain flow schedules
– Check component availability

• Derive schedules for feeder lines from parents
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